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RX Family  

How to implement OTA by using Microsoft Azure 
Services 

 

Introduction  

This document describes how to create an environment that enables deployment of over-the-air (OTA) 
updating of IoT devices using Microsoft Azure. OTA updates employ an Azure service called Device Update 
for IoT Hub. This functionality is referred to as ADU in this document, and a step-by-step guide is presented. 

In addition, by using QE for OTA, it is possible to simplify the process required to build an ADU project. 

Note that the information presented in this document is subject to change without notice. 

 

Target Devices 

• CK-RX65N (Ethernet) 

• Renesas Starter Kit+ for RX65N-2MB (Ethernet) 

• RX65N Cloud Kit (Wi-Fi) 

• RX72N Envision Kit (Ethernet) 

• RX671 RSK (Ethernet) 
 
Note: The descriptions in this document use the CK-RX65N as an example. 

 

Development Environment Used 

Integrated development environment (IDE): e2 studio 2023-04 

Compiler:  Renesas C/C++ Compiler for RX Family CC-RX V3.05.00 

 GCC for Renesas 8.3.0.202204-GNURXGCC 

Driver package (RDP): RX Driver Package V1.39 

Azure RTOS                  : 6.2.1_rel-rx-1.0.1 

Flash programming tool:  Renesas Flash Programmer V3.11.02 

MOT file conversion tool: Renesas Secure Flash Programmer (RX MCUs mot file converter 2.0.2)  
(Installation procedure described separately.) 

Key generation tool:  Win32/Win64 OpenSSL v3.1.1 Light (Installation procedure described separately.) 
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1. Memory Allocation for ADU 

The description in this document assumes that the memory is allocated as shown in the figures below. 

 

The initial firmware and updated firmware each occupy a 1 MB area of memory by the ADU sample project 
for RX65N. 

 

 

Figure 1.1   Memory Allocation for ADU (RX65N)  

 

The various types of data are written to the following addresses in memory. 

0xFFF00000 to 0xFFF002FF: Verification data 

0xFFF00300 to 0xFFFEFFFB: Firmware 

0xFFFEFFFC to 0xFFFFFFFF: Secure bootloader (Boot Loader) 

 

The secure bootloader uses the verification data written to the address range 0xFFF00000 to 0xFFF002FF 
to verify that the previously programmed initial firmware and the updated firmware have not been tampered 
with ((3) and (6) in the above figure). 

After the firmware update, the bank swapping functionality is used to exchange the memory areas containing 
the initial firmware and updated firmware, and then the old firmware is erased ((7) and (8) in the above 
figure). Utilizing the bank swapping functionality makes it possible for the addresses referenced by the 
application to remain unchanged after the firmware update. 
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2. Creating Sample Projects 

This section describes how to create projects that implement ADU. 
ADU uses the secure boot that is RX security features. Therefore the following two sample projects are used 
for ADU operation. 

• Azure Device Update (ADU) sample project  

• Secure bootloader sample project 
 
Follow the steps described in this section to create the two sample projects. It will be necessary to make 
changes to the settings, memory allocation, and source code of the newly created projects, and how to make 
these changes is described as well. 

 

2.1 Creating a Workspace 

Launch e2 studio and create a new workspace. Keep the names of the workspace and project file as short as 
possible. If the total length of the full file path exceeds 256 bytes, an error will occur when you build the 
project.  

Example: Creating a workspace in location C:\workspace 

 

Figure 2.1   Workspace Creation Window 
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2.2 Creating the Sample Projects 

2.2.1 Creating a New ADU Sample Project 

After launching e2 studio, from the File menu select New → Renesas C/C++ Project → Renesas RX to 
open the New C/C++ Project dialog box. 

 

Figure 2.2   Menu Selection to Create a New Project 

 

In the New C/C++ Project dialog box you will select the type of project to be created. Here, select All at the 
left, followed by Renesas CC-RX C/C++ Executable Project, then click the Next > button. A dialog box for 
the project type you selected (New Renesas CC-RX Executable Project) appears. To use GCC, you would 
select GCC for Renesas RX C/C++ Execute Project. 

 

Figure 2.3   Project Type Selection Window 
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Next, specify a name for the project. For Project name: enter adu_sample, then click the Next > button. 
The Select toolchain, device & debug settings dialog box opens. 

 

Figure 2.4   Project Name Setting Window 
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Select the toolchain, device, and debug settings to use for the project. The Toolchain: item is set based on 
the project type you selected earlier. To change the toolchain version, click the down arrow next to 
Toolchain Version: and select the version of your choice. 

For RTOS: select Azure RTOS, and for RTOS Version: select the appropriate version. If you are using 
e2 studio for the first time or if the version you wish to use is not displayed as an option, click Manage RTOS 
Versions... to open the RTOS Module Download dialog box. Check the box next to the version you wish to 
use and click the Download button to download it.  

For Target Board: select CK-RX65N. (Target Device: is selected automatically.) When all the settings have 
been configured, click the Next > button. 

 

Figure 2.5   Select toolchain, device & debug settings Window 

 

 

Figure 2.6   RTOS Module Download Window 
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The Select Coding Assistant settings dialog box appears. Click the Next > button without making any 
changes. 

 

Figure 2.7   Select Coding Assistant settings Window 

 

In the Select RTOS Project Settings dialog box a list of sample projects is displayed. Use the scroll bar to 
scroll down the list, select Azure Device Update (ADU) sample project, and click the Next > button. 

 

Figure 2.8   Select RTOS Project Settings Window 
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The Settings The Contents of Files to be Generated dialog box appears. Click the Next > button without 

making any changes. 

 

Figure 2.9   Settings The Contents of Files to be Generated Window 

 

A dialog box appears indicating that preparation for creation of the project is complete. If there are no 
problems, click the Finish button. 

 

Figure 2.10   Window Indicating Completion of Preparation for Project Creation 
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If the Editors available on the Marketplace dialog box appears, click the Cancel button to dismiss it.  

 

Figure 2.11   Editors available in the Marketplace Window 

 

The project is created in e2 studio as shown below. If the Project Explorer view is not shown, click the C/C++ 

button at the top right of the window and select Window → Show View → Project Explorer from the menu. 

 

Figure 2.12   Window after Creation of ADU Sample Project  
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2.2.2 Creating a New Bootloader Sample Project 

Follow the same procedure as that used to create the ADU sample project to create a bootloader sample 
project. The basic steps are the same as those for the ADU sample project. For Project name: enter 
bootloader, and in the Select RTOS Project Settings dialog box select Secure bootloader sample 
project. All other settings are the same as those for the ADU sample project. 

  

Figure 2.13   Settings for Creating Bootloader Project 
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2.3 Changing Project Settings 

It is necessary to change the settings of the newly created projects in order to implement ADU. Note that the 
steps described in this section must be performed on both the ADU sample project and the bootloader 
sample project. The description of the steps below mainly uses the bootloader sample project as an 
example. 

 

2.3.1 Integrating Components 

When it is first set up, the e2 studio environment may not include certain components. In the description 
below, the firmware update module (FIT) required for ADU is used as an example. 

In Project Explorer, expand the bootloader project tree and double-click bootloader.scfg to open the Smart 
Configurator perspective for the bootloader project. In the Smart Configurator window, select the 
Components tab to open the Software component configuration window. 

On the left of the window a tree of components that need to be integrated is displayed. The firmware update 
module corresponds to the r_fwup item in the tree. 

 

Figure 2.14   Software component configuration Window 

 

Here, icons displayed with a gray overlay indicate components that have not been downloaded to e2 studio. 
Follow the steps below to download these components. 
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1. Click the + button above the component tree. When the Software Component Selection window 

appears, select FWUP Library in the Components listing and click the Finish button. The gray overlay 

disappears from the blue icon in the component tree. (In the case of a component that was not originally 

shown in the tree, a new icon is added to the tree.) 

 

Figure 2.15   Software Component Selection Window 

 

2. Configure initial settings for the firmware update module. Click r_fwup in the component tree, and check 

the settings listed below. Note that the settings differ for the bootloader sample and the ADU sample. 

⎯ bootloader (bootloader) 

• SCI channel used for serial terminals: 5*1 

⎯ ADU (adu_sample) 

• Implementation environment: Azure ADU 

• SCI channel used for serial terminals: 5*1 
 

Note: 1. The sample projects have a mode that allows confirmation of their operating status using a 

terminal emulator program. The serial port (SCI) is used for output to the terminal emulator 

program. In the example above the setting is configured for SCI5 on the CK-RX65N. You 

should configure the setting for the channel that matches the specifications of the target board 

you are using. 

On v1.04 and previous of the firmware update module it is not possible to select Azure ADU for 

Implementation environment. If Azure ADU is not listed, make sure to select v1.06 or later of 

the firmware update module. 
 



RX Family How to implement OTA by using Microsoft Azure Services  

R01AN6928EJ0100  Rev.1.00  Page 15 of 46 

Jul.31.23 

3. After the component has been configured, generate component code.*1 Click the Generate Code button 

at the top right of the Software component configuration window. The generated code is stored in the 

\src\smc_gen folder in the project folder. 

 

Figure 2.16   Generate Code Button 

 
If there are other components with a gray overlay on their icons, repeat the above steps for each of them. 

 
Note: 1. After changing settings in Smart Configurator, make sure to generate code as the final step. 

 

2.3.2 Changing the Device to Dual Mode 

In order to implement ADU, the device must be configured for dual mode, in which the code flash of the 
device is treated as two banks. Perform the steps below to change this setting. 

1. Change the device. 

In Project Explorer, expand the bootloader project tree and double-click bootloader.scfg to open the 

Smart Configurator perspective for the bootloader project. In the Smart Configurator window, select the 

Board tab to open the Device selection window. Click the ... button next to Board: to open the Change 

Device window. 

 

Figure 2.17   Device selection Window 

 
In the Change Device window, change the value of the Target Device: item to R5F565NEHxFB_DUAL. 

You can click the ... button to the right of the text entry field to choose from a list of candidates. Leave the 

Target Board: setting of Custom unchanged.  

After changing the device, click the Next > button. On the information window that appears, click the 

Next > button again without making changes. 

 

Figure 2.18   Change Device Window 
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Finally, a window appears asking you to confirm the change. Click the Finish button. This completes the 

process of changing the device. If a window like that shown below asking you to confirm a change of 

target board appears, click the No button. 

 

Figure 2.19   Target Board Change Confirmation Window 

 

After making the change, check the Device selection window to confirm that Board: is set to Custom 

User Board and Device: is set to R5F565NEHxFB_DUAL. 

After changing settings in Smart Configurator, click the Generate Code button to generate code reflecting 

the changed settings. 
 
2. Configure section settings. 

After changing the device to dual mode, refer to the next section and make the necessary setting 

changes to allocate the memory for dual mode.*1 
 
Note: 1. After the device is changed, the section settings are cleared to their default values. 
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2.3.3 Section Information Settings 

The section information is initialized to the default values after the device is changed to dual mode, so it is 
necessary to reconfigure the settings. Follow the steps below to configure the section information settings. 

1. CC-RX: 

In Project Explorer, right-click the bootloader project and select Properties → C/C++ Build → Settings 

→ Tool Settings tab → Linker → Section, and click the … button. 

 

Figure 2.20   Launching Section Viewer 

 
Section data for the sample is contained in the src folder. Click the Import… button and import the 

section data file named linker_section_sample.esi. Note that importing the file overwrites the section 

information. 

 

Figure 2.21   Bootloader Sample (CC-RX) Section Settings 
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The section data of the bootloader sample and ADU sample are different, so when configuring the section 

data for the ADU sample, make sure to import the file in the src folder of the ADU sample project named 

linker_section_sample.esi. 

 

Figure 2.22   ADU Sample (CC-RX) Section Settings 

2. GCC 

Please rename \src\linker_script_sample.ld of the adu_sample project to \src\linker_script.ld and 

overwrite it. Open \src\linker_script.ld in the bootloader project, click the linker_script.ld tab, and 

confirm that .text is set to 0xFFFF0000, .exvectors to FFFFFF80, and .fvectors to FFFFFFFC as shown 

in the figure below. Also confirm that the AT() values in brackets match the above.  

 

Figure 2.23   Bootloader Sample (GCC) Section Settings  
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The section data of the bootloader sample and ADU sample are different. 

Please rename \src\linker_script_sample.ld of the adu_sample project to \src\linker_script.ld and 

overwrite it. Open \src\linker_script.ld in the adu_sample project, click the linker_script.ld tab, and 

confirm that .text is set to 0xFFF00300, .exvectors to FFFEFF80, and .fvectors to FFFEFFFC as shown 

in the figure below. Also confirm that the AT() values in brackets match the above. 

 

Figure 2.24   ADU Sample (GCC) Section Settings 

 

2.3.4 Adding a Section Mapped from ROM to RAM 

Add a definition for a section mapped from ROM to RAM. In Project Explorer, right-click the bootloader 

project and select Properties → C/C++ Build → Settings → Tool Settings tab → Linker → Section → 
Symbol file, and click the + button to the right of ROM to RAM mapped section (-rom). Enter the value 
FRAM2=RPFRAM2 and click the OK button. 

This setting applies to the CC-RX only. It is not required on the GCC. 

 

 

 

Figure 2.25   Adding a Section Mapped from ROM to RAM 
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2.4 Creating Key Information 

This section describes how to generate key information used for settings in the sample project. OpenSSL is 
used to generate key information. 

 

2.4.1 Installing OpenSSL 

Access the Win32/Win64 OpenSSL download site, download the OpenSSL installer that matches your OS 
version, and run it to install the software. 

After installation completes, open System Properties → Environment Variables in Windows and add the 
OpenSSL install folder to the Path environment variable. 

64-bit version: C:\Program Files\OpenSSL-Win64\bin 

 

2.4.2 Generating a Key Pair for ECC in OpenSSL 

The MOT file conversion tool, which you will need to use later, requires you to specify an ECC public key and 
private key. You can use OpenSSL to generate these keys. Enter the character strings shown below in blue, 
substituting appropriate values of your choice for the input values shown, at the command prompt. 

Some commands require you to input settings. Enter the character strings shown below in blue. 

If you just want to generate the ECC public and private keys, steps B, E, and F are sufficient. 

A. Create a CA Certificate 

openssl ecparam -genkey -name secp256r1 -out ca.key  

using curve name prime256v1 instead of secp256r1 
 

openssl req -x509 -sha256 -new -nodes -key ca.key -days 3650 -out ca.crt 

You are about to be asked to enter information that will be incorporated into your certificate request.  

What you are about to enter is what is called a Distinguished Name or a DN. 

There are quite a few fields but you can leave some blank  

For some fields there will be a default value, 

If you enter '.', the field will be left blank. 

Country Name (2 letter code) [AU]:JP 

State or Province Name (full name) [Some-State]:Tokyo  

Locality Name (eg, city) []:Kodaira 

Organization Name (eg, company) [Internet Widgits Pty Ltd]:Renesas Electronics  

Organizational Unit Name (eg, section) []:Software Development Division  

Common Name (e.g. server FQDN or YOUR name) []:Renesas Tarou 

Email Address []:Tarou.Renesas@sample.com 
 
B. Generate a Key Pair for Elliptic Curve Cryptography (Parameter: secp256r1)  

openssl ecparam -genkey -name secp256r1 -out secp256r1.keypair 

using curve name prime256v1 instead of secp256r1 
 

https://slproweb.com/products/Win32OpenSSL.html
mailto:Tarou.Renesas@sample.com
mailto:Tarou.Renesas@sample.com
mailto:Tarou.Renesas@sample.com
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C. Create a Certificate for the Key Pair 

openssl req -new -sha256 -key secp256r1.keypair > secp256r1.csr  

You are about to be asked to enter information that will be incorporated  

into your certificate request. 

What you are about to enter is what is called a Distinguished Name or a DN.  

There are quite a few fields but you can leave some blank 

For some fields there will be a default value,  

If you enter '.', the field will be left blank. 

Country Name (2 letter code) [AU]:JP 

State or Province Name (full name) [Some-State]:Tokyo  

Locality Name (eg, city) []:Kodaira 

Organization Name (eg, company) [Internet Widgits Pty Ltd]:Renesas Electronics  

Organizational Unit Name (eg, section) []:Software Development Division 

Common Name (e.g. server FQDN or YOUR name) []:Renesas Tarou 

Email Address []:Tarou.Renesas@sample.com  

Please enter the following 'extra' attributes 

to be sent with your certificate request  

A challenge password []: 

An optional company name []: 
 
D. Use the CA Certificate to Create a Certificate for the Key Pair 

openssl x509 -req -sha256 -days 3650 -in secp256r1.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out 

secp256r1.crt 

Signature ok 

subject=/C=JP/ST=Tokyo/L=Kodaira/O=Renesas Electronics/OU=Software Development  

Division/CN= Renesas Tarou/emailAddress= Tarou.Renesas@sample.com 

Getting CA Private Key 
 
E. Extract a Private Key for Elliptic Curve Cryptography (Parameter: secp256r1)  

openssl ec -in secp256r1.keypair -outform PEM -out secp256r1.privatekey  

read EC key 

writing EC key 
 
F. Extract a Public Key for Elliptic Curve Cryptography (Parameter: secp256r1)  

openssl ec -in secp256r1.keypair -outform PEM -pubout -out secp256r1.publickey  

read EC key 

writing EC key 
 
 

mailto:Tarou.Renesas@sample.com
mailto:Tarou.Renesas@sample.com
mailto:Tarou.Renesas@sample.com
mailto:Tarou.Renesas@sample.com
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2.4.3 Entering a Public Key 

Open \src\key\code_signer_public_key.h from the bootloader project and the secp256r1.publickey file 
generated by OpenSSL in a text editor. Copy the contents of secp256r1.publickey to 
CODE_SIGNENR_PUBLIC_KEY_PEM. 

Note that each line must be enclosed in straight quotes ("") and end with the backslash character (\). 

 

Figure 2.26   Public Key Information Setting 

 

2.5 Building the bootloader Project 

Build the bootloader project and create a bootloader.mot file. 

The MOT file is created in the following folder. 

\bootloader\HardwareDebug/ 
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2.6 Connection Information Macro Settings 

Open \src\sample_config.h from the adu_sample project and specify setting values for HOST_NAME, 
DEVICE_ID, and DEVICE_SYMMETRIC_KEY. For the setting values, refer to the parameters configured on 
the Azure portal as described in 3.1, IoT Hub and Device Registration. 

 

Figure 2.27   Azure Connection Information Settings 

 

It is necessary to configure Wi-Fi connection settings in order to use RX65N Cloud Kit. Open 
\src\hardware_setup.h from the adu_sample project and specify setting values for WIFI_SSID and 
WIFI_PASSWORD. For the setting values, refer to the SSID and password of the Wi-Fi access point you 
wish to connect to. 

 

Figure 2.28   Wi-Fi Connection Information Settings 

 

2.7 Checking the Initial Firmware Version 

Confirm that the initial firmware version is 1.0.0. Open \src\sample_azure_iot_embedded_sdk_adu.c from 
the adu_sample project and check to confirm that the value of SAMPLE_DEVICE_INSTALLED_CRITERIA  
is 1.0.0. 

 

Figure 2.29   Initial Firmware Version 

 

2.8 Building the adu_sample Project 

Build the adu_sample project and create a adu_sample.mot file. 

The MOT file is created in the following folder. 

\adu_sample\HardwareDebug\ 
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2.9 Creating the Initial Firmware 

Create the initial firmware to be downloaded to the target board. 

Create the initial firmware by combining the bootloader and firmware. 

Access the Renesas Secure Flash Programmer (RX MCUs mot file converter 2.0.2), download the Source 
Code(zip) and unzip it at a folder of your choice. 

 

Figure 2.30   Renesas Secure Flash Programmer Download Page 

 

After the download completes, double-click the file mot-file-converter-2.0.2\Renesas Secure Flash 
Programmer\bin\Debug\Renesas Secure Flash Programmer.exe to launch the program. 

Click the Initial Firm tab and enter the following settings. 

• Select MCU: RX65N Flash(Code=2MB, Data=32KB)/Secure Bootloader=64KB  

• Select Firmware Verification Type: sig-sha256-ecdsa 

• Private Key Path (PEM format): secp256r1.privatekey generated by OpenSSL in step E 

• Select Output Format: Bank 0 User Program + Boot Loader (Motorola S Format) 

• Boot Loader File Path (Motorola Format): \bootloader\HardwareDebug\bootloader.mot 

• Firmware Sequence Number: 1 

• Bank 0 User Program File Path (Motorola format): \adu_sample\HardwareDebug\adu_sample.mot 
 

 

Figure 2.31   Initial Firmware Creation Window 

 

Finally, click the Generate... button and save the file userprog.mot to a folder of your choice. The process is 
complete when the message “generate succeeded.” appears at the bottom of the window. 

https://github.com/renesas/mot-file-converter/releases/tag/2.0.2
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The structure of the generated userprog.mot file is shown below. The verification data, initial firmware, and 
bootloader are contained in a single MOT file. The verification data includes information such as keys used 
to verify the firmware. 

 

Figure 2.32   Structure of userprog.mot File 

 

2.10 Installing the Flash Programming Tool 

Access the Renesas Flash Programmer download site, download the Renesas Flash Programmer V3.11.02 
Windows installer, and run it to install the tool. 

 

2.11 Launching Initial Firmware 

A) Flash Programming of Initial Firmware (Linear Mode → Dual Mode) 

The initial firmware is programmed to the RX65N in its initial state, which is linear mode. First, launch 

flash_project.rpj, which is located in the \adu_sample\tools\Flash_Project\CKRX65N_ADU_Write 

folder. Next, on the Operation tab specify userprog.mot for Program File and click the Start button to 

program the previously generated initial firmware file userprog.mot to the RX65N. 

Programming is complete when the message “Operation completed.” appears at the bottom of the 

window.  

 

Figure 2.33   Programming the Initial Firmware to the Device 

 

Running the initial firmware transitions the MCU from linear mode(normal mode) to dual mode (a mode in 

which the code flash memory is divided into two banks). Subsequently, if it is necessary once again to 

program the initial firmware to the flash memory, first perform B) to erase the flash memory and change to 

linear mode, then A) to program the flash memory. 
 

https://www.renesas.com/jp/ja/software-tool/renesas-flash-programmer-programming-gui#download
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B) Flash Erasing (Dual Mode → Linear Mode) 

The ROM is initialized by "Flash Erasing", and the RX65N changes from dual mode to linear mode. 

Launch erase_project.rpj in the CKRX65N_ADU_Erase folder in tools/Flash_Project and click the Start 

button on the Operation tab to erase the chip. 

Renesas Flash Programmer recognizes linear mode and dual mode as separate MCUs. Since A) is 

recognized as linear mode and B) is recognized as dual mode, when A) or B) is executed consecutively, 

“Error (E3000107): This device does not match the connection parameters.” will occur. 
 
After programming of the initial firmware finishes, the program runs on the RX65N. The execution results can 
be confirmed by using terminal software. After the program runs, the bootloader runs and decrypts the 
encrypted hash value using the public key that was programmed to the verification data area. It also 
calculates a hash value for the firmware overall and confirms that it matches the decrypted hash value. If the 
values match, it launches the firmware. 

Boot Loader

Verification data

Boot Loader

Verification data

Verify

Write

Boot Loader

Initial

firmware 

Verification data

Boot Loader

(mirror)
Copy

BootInitial

firmware 
Initial

firmware 

 

Figure 2.34   Bootloader Operation 

 

2.12 Modifying the Code of the Updated Firmware 

Open \src\sample_azure_iot_embedded_sdk_adu.c from the adu_sample project and change the value 
of SAMPLE_DEVICE_INSTALLED_CRITERIA to 1.1.0.*1 

Note: 1. If the firmware version set in the Azure IoT Hub is already present, set the value to a different 

version number. 

 

If necessary, add any needed update processing. 

 

Figure 2.35   Updated Firmware Setting 
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2.13 Building the Updated Firmware 

Build the adu_sample project and create an adu_sample.mot file. 

 

2.14 Creating the Updated Firmware 

Convert the updated firmware to RSU format.*1 

Double-click the file mot-file-converter-2.0.2\Renesas Secure Flash Programmer\bin\Debug\Renesas 
Secure Flash Programmer.exe to launch the program. Then click the Update Firm tab and enter the 
following settings. 

• Select MCU: RX65N Flash(Code=2MB, Data=32KB)/Secure Bootloader=64KB 

• Select Firmware Verification Type: sig-sha256-ecdsa 

• Private Key Path (PEM format): secp256r1.privatekey generated by OpenSSL in step E 

• Firmware Sequence Number: 1 

• File Path (Motrola format): \adu_sample\HardwareDebug\adu_sample.mot 
 

 

Figure 2.36   Updated Firmware Creation Window 

 

Finally, click the Generate... button to save userprog.rsu. 

The process is complete when the message “generate succeeded.” appears at the bottom of the window. 

The structure of the generated userprog.rsu file is shown below. The binary file contains both the 
verification data and the updated firmware. 

 

Figure 2.37   Structure of userprog.rsu File 
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Note:  1.  The MOT file format, the data format generally used for firmware, provides no mechanism for 

storing data other than the actual data to be programmed to the device (for example, verification 

data such as hash values). In addition, MOT files consist of text data, so they tend to be around 

twice as large as files consisting of binary data. 

To avoid these limitations, Renesas Secure Update (RSU), an binary file format exclusive to 

Renesas that allows storage of verification data(Other data such as hash values) alongside the 

actual firmware data, is used for ADU releases. Refer to section 7.1, Download Data Format, in 

the application note Renesas MCU Firmware Update Design Policy for an overview of RSU files. 

Also, this item provides details of the verification data (0x00000000 to 0x000002FF). 

 

Once the updated firmware has been created, refer to section 3, Operations on Microsoft Azure Portal, and 
follow the instructions to register the updated firmware on the IoT Hub and update the firmware. 

 

https://www.renesas.com/br/en/document/apn/renesas-mcu-firmware-update-design-policy-rev100
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3. Operations on Microsoft Azure Portal 

The Microsoft Azure operation procedure for implementing ADU is described below. 

 

3.1 IoT Hub and Device Registration 

Create an IoT Hub and device on the Azure portal.*1 This process is described in section 3.1 of the 
application note Visualization of Sensor Data using RX65N Cloud Kit and Azure RTOS. 

Note: 1. In order to implement ADU it is necessary to select the Standard tier and edition type S1 in the 

pricing options for the IoT Hub. Note that it is not possible to implement ADU using the Free 

edition type.  

 

The following three parameters of the newly created IoT Hub are declared in the ADU sample source code. 

• Host name: HOST_NAME  

• Device ID: DEVICE_ID 

• Primary key: DEVICE_SYMMETRIC_KEY 
 
 

3.2 Creating a Device Update Account and Instance 

Follow the guide at the link below to create a Device Update account and instance on the Azure portal. 

Create Device Update for IoT Hub resources 

 

The newly created Device Update for IoT Hub account is assigned to the same resource group as the IoT 
Hub.*1 

Also create a storage container for uploading updated firmware. 

Note: 1. Be aware that a paid account is required in order to use Device Update. 

 

3.3 Preparing the Updated Firmware 

 

3.3.1 Building the Updated Firmware 

Follow the procedure described in section 2 to create the updated firmware and generate a binary file. A 
binary file for use by the secure bootloader must be in RSU file format. Follow the procedure to create an 
RSU file. 

 

3.3.2 Creating a Manifest File 

A manifest file is a JSON file that defines information about the updated program required by Device Update 
for IoT Hub. The manifest file and binary file are used as a pair when uploading updated firmware to a IoT 
Hub. Follow the steps below to create a manifest file. 

1. PowerShell v7.0 is used to create manifest files. Download and run the installer that matches your OS. 

 

Figure 3.1   PowerShell Installer Download 

 

https://www.renesas.com/jp/ja/document/apn/rx65n-group-visualization-sensor-data-using-rx65n-cloud-kit-and-azure-rtos-rev100?language=en
https://learn.microsoft.com/en-us/azure/iot-hub-device-update/create-device-update-account?tabs=portal
https://github.com/PowerShell/PowerShell/releases/tag/v7.0.3
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2. Launch PowerShell and change the current directory to the directory containing the scripts for creating 

ADU project manifest files. 

\adu_sample\tools\AzureDeviceUpdateScripts 
 
3. Run the following command in PowerShell. 

Set-ExecutionPolicy -ExecutionPolicy RemoteSigned -Scope Process 
 
4. Copy the RSU file created as described in 2.14, Creating the Updated Firmware, to the folder referenced 

in step 2. Change the name of the copied RSU file to the following. 

firmware_1.1.0.rsu 
 

Replace 1.1.0 in the file name with the version number specified for the updated firmware. Also, do not 

change the file name again after the manifest file has been created. 
 
5. Run the script shown below. Some items require input when the script is run, so enter the character 

strings shown in blue text below. The names of the scripts differ according to the names of the target 

boards they are intended to be used with. When reading the explanation, replace the relevant portion of 

the file name of the script as appropriate. The LeafPath item refers to the path setting of the child device 

connected to the target board, so press the Enter key for this item without entering anything. 

.\CreateCKRX65NUpdate.ps1 

 

cmdlet CreateCKRX65NUpdate.ps1 at command pipeline position 1 

Supply values for the following parameters: 

(Type !? for Help.) 

Version: 1.1.0 

HostPath: ./firmware_1.1.0.rsu 

LeafPath: 

Preparing update RENESAS.CK-RX65N.1.1.0 ... 

Preparing parent update RENESAS.CK-RX65N.1.1.0 ... 

Generating an import manifest RENESAS.CK-RX65N.1.1.0... 

Saving parent manifest file and payload(s) to .\RENESAS.CK-RX65N.1.1.0... 
 

 

Figure 3.2   Script Run Window 

 
6. When the script completes successfully, a folder named RENESAS.CK-RX65N.1.1.0 is created in the 

script folder with the RSU file and manifest file listed below saved to it. Store these two files in the storage 

container. 

⎯ RENESAS.CK-RX65N.1.1.0.importmanifest.json 

⎯ firmware_1.1.0.rsu 
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3.4 Uploading the Firmware Update to the Storage Container 

Upload the previously generated updated firmware to the storage container. On the Home page of the Azure 
portal, perform the following steps. 

On the Home page, click Storage accounts → <name of storage account to use> → Containers (under 

Data storage) → <name of container to use>. The Containers page appears. On the Containers page, 
click Upload to display the page for uploading updates (Upload blob). 

 

 

 

Figure 3.3   Containers Page 
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Drag and drop to the Upload blob page the RENESAS.CK-RX65N.1.1.0 folder containing the firmware 
update binary file and manifest file prepared as described in section 3.3. When the files are registered, click 
the Upload button. When the upload completes, click the × button to close the Upload blob page. The 
added folder (or files) appear in the container contents list. 

 

 

 

Figure 3.4   Uploading Update Files 
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3.5 Registering the Firmware Update 

Register the firmware update uploaded to the storage container on the IoT Hub page. For the IoT Hub you 
are using, click Updates under Device management to display a list of updates. On this page, click 

Updates tab → Import a new update. 

 

Figure 3.5   Updates List Page 

 

The Import update page is displayed. Enter a description of the firmware update in the Descriptive label 
text field and click Select from storage container. 

 

Figure 3.6   Entering a Description of the Update 
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Click <name of storage account> → <name of container> corresponding to the location to which you 
uploaded the firmware. Check the boxes next to the names of the firmware binary file and manifest file 
previously registered on the Containers page, and click the Select button. 

 

Figure 3.7   Selecting Update Files 

 

The files you checked are already registered on the Import update page, so click the Import update button. 

 

Figure 3.8   Import update Page 

 

If the import completes successfully, the imported firmware is added to the list of updates. 

 

Figure 3.9   List of Updates 
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3.6 Creating an ADU Group 

Add an ADU group to the update. Configure settings to add an ADU group in order to link the IoT Hub device 
and the ADU group. On the IoT Hub page, click Devices under Device management. From the list of 
devices, select the device created as described in 3.1 to open the Device settings page. On the Device 
settings page, click Tags (edit) to display the Edit tags page. 

 

Figure 3.10   Device settings Page 

 

On the Edit tags page, enter values for Name and Value. For Name enter ADUGroup, and for Value enter 
a character string of your choice. After entering the above, click the Save button to close the Edit tags page. 
Confirm that the Name and Value tags you specified have been registered on the Device settings page, 
then click the Save button at the top left of the page. 

 

Figure 3.11   Edit tags Page 

 

On the IoT Hub page, click Updates under Device management → Groups and Deployments. The group 
for which you specified the Value tag should have been added to the list of groups that is displayed.*1 

Note: 1. A group may fail to be added to the list of ADU groups in the case of a device where no 

communication has ever taken place with the target board. In this case, connect once from the 

target board to the IoT Hub device to be used with ADU. 
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3.7 Updating the Firmware 

Download the firmware update registered to the IoT Hub to the target board. 

 

3.7.1 Execution on the Target Board 

To begin, run the initial firmware previously programmed to the target board. On the CK-RX65N, configure 
the J16 jumper pins for “RUN” and make a connection to the J14 USB connector to start operation. 

Also, by connecting a PC to the J12 USB connector it is possible to monitor the operating state using a 
terminal emulator program such as Tera Term. When you establish a USB connection between J12 and the 
PC, a port is registered in Windows Device Manager. You can then connect to the target board by specifying 
the newly registered COM port number in the terminal emulator program. Configure the serial port 
communication settings as follows. 

• Data rate: 115,200 bps 

• Data bits: 8 

• Stop bits: 1 

• Parity: None 
 
When you run the project, the sample program sends status information as serial output to the terminal 
emulator program, as shown in the example below.*1 Check the text displayed by the terminal emulator 
program to confirm that a connection has successfully been established to the IoT Hub and device. Also 
confirm the current firmware version indicated following Installed Criteria:. 

Note: 1. The information output to the terminal emulator program may differ depending on which project 

you built. 

 

Figure 3.12   Output in Terminal Emulator Window (Example) 
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3.7.2 Deploying the Firmware Update  

Deploy the firmware update from the IoT Hub to the environment, and update the target firmware. For the IoT 
Hub you are using, click Updates under Device management to display a list of updates, and then click 
Groups and Deployments. A list of devices in the device group is displayed. 

 

Figure 3.13   Groups and Deployments Display 

 

Groups are displayed in the list of device groups using ADU group names registered as described in 3.6. 
Click the group name to be used as the firmware update. The Group details page appears. On the Group 
details page, click the Group basics tab and then click Deploy in the center of the page. Alternatively, you 
can click Deploy next to the desired group name on the Groups and Deployments page. 

 

Figure 3.14   Group details Page 
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On the New updates page that appears, check that the version number is correct, then click the Deploy 
button. The Create deployment page is displayed. 

 

Figure 3.15   New updates Page 

 

On the Create deployment page, click the Create button. Deployment starts. 

 

Figure 3.16   Create deployment Page 

 

Once deployment starts, the download status is output to the terminal emulator program connected to the 
CK-RX65N. The downloaded firmware update is written to the flash memory, and version checking and 
verification data are used to verify the firmware. Next, bank switching takes place on the device, and the 
firmware update is applied after a software reset. 

 

Figure 3.17   Downloading the Firmware  
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After the firmware is downloaded, the update is complete when the firmware version indicated following 
Installed Criteria: matches that of the firmware update. 

 

Figure 3.18   Firmware Update Complete 

 

After the firmware update finishes, the Deployment status shown on the Group details page is 
Succeeded. 

 

Figure 3.19   Group details Page 
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You can deploy a version of the firmware that is not the latest version by clicking the applicable group name 
in the device group list, clicking the Current updates tab on the Group details page, and then clicking View 
available updates under Deployment details to display the Available updates page. You can then select 
the desired version from a list and deploy it. 

 

 

 

Figure 3.20   Selecting Among Available Updates 

 



RX Family How to implement OTA by using Microsoft Azure Services  

R01AN6928EJ0100  Rev.1.00  Page 41 of 46 

Jul.31.23 

4. Appendix 

How to source debug initial and updated firmware using e2 studio is described below. 

 

4.1 Debugging the Initial Firmware 

1. Change the debug settings for the bootloader project as follows in e2 studio. 

From the menu bar select Run → Debug Configurations..., and then click bootloader Hardware 

Debugging in the pane at the left of the Debug Configurations window. Click the Main tab, click the 

Browse… button under C/C++ Application:, and select the userprog.mot file containing the initial 

firmware created as described in 2.9, Creating the Initial Firmware. 

 

Figure 4.1   Specifying userprog.x for C/C++ Application 

 
Select Debugger tab → Connection Settings and set Startup bank to Bank 0. 

 

Figure 4.2   Changing the Startup Bank 
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Select Debugger tab → Debug Tool Settings and set Debug the program re-writing the on-chip 

PROGRAM ROM to Yes. 

 

Figure 4.3   Debug Tool Settings Tab 

 
2. In the debug settings for the same bootloader project, click the Startup tab and under Load image and 

symbols add items and settings as follows. 

• Change the Load type of userprog.mot to Image only. 

• Add adu_sample.x by clicking Add… → File system... and change the Load type to Symbols only. 

• Add bootloader.x by clicking Add… → File system... and change the Load type to Symbols only. 

 

Figure 4.4   Load image and symbols Settings 

 

 



RX Family How to implement OTA by using Microsoft Azure Services  

R01AN6928EJ0100  Rev.1.00  Page 43 of 46 

Jul.31.23 

3. Start debugging the bootloader project and make sure it breaks at the main function of 

bootloader/src/bootloader.c. Also, check that the firmware starts normally by setting a breakpoint at the 

main function in adu_sample/src/main.c. 

[bootloader.c] 

 

Figure 4.5   Breakpoint in bootloader.c 

 

[main.c] 

 

Figure 4.6   Breakpoint in main.c 

 
If execution does not break at the main function, set a breakpoint at the location shown above. 

 

When generating the initial firmware userprog.mot, a MOT file with blank area filled with 0xFF is generated. 
In other words, even if you are not using the data flash area, this area is filled with 0xFF. At this time, if you 
rewrite the data in the data flash area by the program, download initial firmware again, and execute 
debugging, it will be overwritten with 0xFF. 

In this case, copy the rewritten data flash area before downloading initial firmware, and write it back after 
downloading. In the case of e2 studio, it is possible to output the memory contents to a file and read it from 
the file by using the dump/restore command. 

 

Example:  
To output the data flash area at address 0x100000-0x107FFF to S-format file and read it, execute the 
following GDB command in the Debugger Console view. 

• When outputting to memdump.mot file 

 
 
• When writing from memdump.mot file to memory 

 
 
Note that memdump.mot is generated in the project folder. 

 

dump srec memory memdump.mot 0x100000 0x107FFF 

restore memdump.mot 0 0x100000 0x107FFF 
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4.2 Debugging the Updated Firmware 

To debug the firmware update, create separate projects for the initial firmware and firmware update. Running 
the bootloader executes the initial firmware. 

1. Set breakpoints after the initial firmware boots and just before the bootloader boots the updated firmware. 

The following process in the bootloader/src/smc_gen/r_fwup/src/r_fwup_boot_loader.c file is the 

process that boots the updated firmware. 

[r_fwup_boot_loader.c] 

 

Figure 4.7   Location of Breakpoint 

 
2. After updating the firmware with ADU, a bank swap and software reset occur. 

3. Just before the updated firmware starts, it breaks at the breakpoint specified in step 1 above. 

4. After the break, execute the following GDB command to update the symbol information. Use the 

Debugger Console at the bottom of e2 studio to execute GDB commands. 

Example: If the updated firmware .x file is in C:\temp*1 

symbol-file C:/\temp/\adu_sample.x -readnow 
 
Note: 1. Add a forward slash (/) before each backslash (\) when specifying the path. 

 

Figure 4.8   Command to Update Symbol Information 

 
5. After you set a breakpoint in any source code of the updated firmware and restart debugging, confirm that 

it breaks at that breakpoint. 
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Online technical support and information is available at:  https://en-support.renesas.com/dashboard 

Technical contact details: https://www.renesas.com/us/en/support/contact.html 

 

  

https://en-support.renesas.com/dashboard
https://www.renesas.com/us/en/support/contact.html
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 

system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 

disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 

that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 

not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.5.0-1  October 2020) 
 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 

Koto-ku, Tokyo 135-0061, Japan 

www.renesas.com 

 For further information on a product, technology, the most up-to-date 

version of a document, or your nearest sales office, please visit: 

www.renesas.com/contact/. 

Trademarks   

Renesas and the Renesas logo are trademarks of Renesas Electronics 

Corporation. All trademarks and registered trademarks are the property 

of their respective owners. 
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